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     Safety Issues 

Check CDR USB Remote HS before Using It 
There are no customer-serviceable components in the CDR USB Remote HS. However, 
before each usage, check the outer surface of the CDR USB Remote HS for any signs of 
physical damage or defect. The surface of the CDR USB Remote HS should have a smooth 
finish, with no evidence of chipping or damage. If detected, contact your local distributor 
of Schick Technologies products for further instructions. 

To help ensure proper hygiene and to protect against infectious disease, refer to the 
Protective Measures section of this document and observe all device cleaning and patient 
protection recommendations specified there. 

Operate the CDR USB Remote HS as Directed 
Always use the CDR USB Remote HS in accordance with the directions and 
recommendations contained in this User Guide. Do not attempt to modify the CDR USB 
Remote HS or use it in system configurations not specified in this document. 

Do Not Touch Exposed Connectors on Non-Medical Equipment and the 
Patient at the Same Time  
When the CDR USB Remote HS is in use, avoid touching exposed connectors on non-
medical electrical equipment and the patient at the same time. The human body is capable 
of conducting electrical current and may cause a shock hazard to patients if appropriate 
safety practices are not observed. 

RF Interference Considerations  
Although the CDR USB Remote HS equipment is designed to provide a reasonable degree 
of protection from electromagnetic interference, according to IEC International 
regulations, it must be installed at an adequate distance from electricity transformer rooms, 
static continuity units, two-way amateur radios and cellular phones. To ensure proper 
operation, the latter (meaning, electricity transformer rooms, static continuity units, two-
way amateur radios and cellular phones) can be used only at a minimum distance of 5 feet 
(1.5m) from any part of the CDR USB Remote HS. 

Any instrumentation or equipment for professional use located near the CDR USB Remote 
HS must conform to Electromagnetic Compatibility regulations, to which the EMC tables 
in this document’s Appendix serve as guidance. Non-conforming equipment, with known 
poor immunity to electromagnetic fields, may not operate properly unless they are installed 
at a distance of at least 10 feet (3m) and supplied by a dedicated electrical line. 

Apply Recommended Procedures for Cleaning the Equipment 
Safe and proper operation of the equipment requires following a regular schedule of 
preventive maintenance. Refer to “Protective Measures” in this document for details. 
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Do Not Connect Items that are Not Part of the System 
Only items specified for use with the CDR USB Remote HS device are to be connected to 
it. The device should not be used adjacent to other equipment that is not part of the system. 
If, however, use with adjacent equipment is necessary, normal operation should be 
observed and verified in that configuration. 

Installers to Ensure that CDR USB Remote HS Operates Optimally 
Installers must ensure that the CDR USB Remote HS provides the user with the optimal 
use of the equipment. This includes, but is not limited to, ensuring the system operates as 
described in this document. Installers must also ensure that the system presents no physical 
obstacles or hazards during operation and when not in use. To verify this requirement, 
installers shall confirm that the CDR USB Remote HS is installed as described in this User 
Guide and shall perform the appropriate procedures therein. 

Ensure Proper System and PC Workstation Installation and Operation  
The CDR USB Remote HS has been determined to be in accordance with international 
safety standards and is deemed suitable for use within the patient area, which extends from 
the patient for a distance of 5 feet (1.5m). To comply with these standards, do not operate 
non-medical equipment (such as a PC workstation) inside the patient area. Outside the 
patient area, the presence of approved non-medical grade equipment and Listed / Approved 
/ certified Information technology Equipment (ITE) computer equipment is acceptable. 

The host computer (PC workstation) should be CE-approved and conform with the Low 
Voltage [73/23/EC] and EMC Directive [89/336/ERC]. Also, to help ensure optimal 
performance, ensure that all software programs residing on the workstation are virus-free 
and have been adequately tested so they will not impact imaging applications after 
installation. 

Only Dentists or Authorized Designees Are Permitted to Operate the System 
To ensure the correct use of the CDR USB HS device in a clinical environment, for 
purposes that correspond to its intended design and application, only dentists, or their 
designees, are authorized to operate the system. 
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Explanation of Symbols 

Refer to the following table for symbols found on the Remote HS itself, on packaging in 
which the equipment is shipped, or in the text of this or other documents provided with the 
system. 

Symbol Description 

 
Indicates Class II equipment in accordance with applicable medical device safety 
standards (IEC/EN/UL 60601-1) 

 
Indicates Type BF equipment in accordance with applicable medical device safety 
standards (IEC/EN/UL 60601-1) 

 
Indicates an attention to users to consult accompanying documents (this User Guide) for 
more information 

 
Conforms to European Union Medical Devices Directive (MDD) 93/42/EEC  

 

Indicates that this product meets North American safety standards. The ETL mark is a 
Nationally Recognized Testing Lab (NRTL) marking and indicates conformance with UL 
60601-1 and CAN/CSA STD C22.2 NO 601.1-M90  

 

Indicates that in the European Union, at the end of product life this device must be 
disposed of in accordance with the requirements of the Waste Electrical and Electronic 
Equipment (WEEE) directive 2002/96/EC 

 
 

Label Location 
The Schick logo and the following label can be found on the CDR USB Remote HS.  
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Waste Electrical and Electronic Equipment   

Background 
The European Union’s Waste Electrical and Electronic Equipment (WEEE) Directive 
(2002/96/EC) has been implemented in member states as of August 13, 2005. This 
directive, which seeks to reduce the waste of electrical and electronic equipment through 
re-use, recycling, and recovery, imposes several requirements on producers. Schick 
Technologies and its Dealers are committed to complying with the Directive.  

WEEE Marking 
All Schick products subject to the WEEE Directive and shipped after August 13, 2005 will 
be compliant with the WEEE marking requirements. These products will be identified with 
the “crossed-out wheeled bin” WEEE symbol shown below, as defined in European 
Standard EN 50419, and in accordance with WEEE Directive 2002/96/EC. 

 
 

This “crossed-out wheeled bin” symbol on the product or on its packaging 
indicates that this product must not be disposed of with other unsorted municipal 
waste. Instead, it is user’s responsibility to dispose of EE waste equipment by 
handing it over to a designated collection point for the reuse or recycling of waste 
electrical and electronic equipment. The separate collection and reuse or recycling 
of Electrical & Electronic waste equipment will help to conserve natural resources 
and ensure that it is recycled in a manner that protects the environment and human 
health. For more information about where you can drop off your waste equipment 
for recycling, please contact your local officials. 

Reporting 
According to the WEEE Directive, Schick Technologies or its Dealers will ensure that 
information needed to calculate the financial obligations with respect to EEE products will 
be provided as required. 

WEEE from Users other than Private Households 
According to the WEEE Directive, Schick Technologies or its Dealers will fulfill its 
obligations for the management of WEEE from users other than private households. 

Furthermore, as required by the WEEE Directive, in order to determine unequivocally  
when the equipment was put on the market, the maufacturer’s date is placed on the 
equipment. 
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Information for Reuse Centers, Treatment and Recycling Facilities 
As required by the WEEE Directive, Schick Technologies or its Dealers will provide reuse, 
treatment, and recycling information for each type of new EEE put on the market within 
one year of the date in which the equipment is put on the market. 

Information will include the different EEE components and materials as well as the 
location of substances in these items. The information will be provided as a printed 
document or in electronic media (on CD-ROM or by web download, for example) 
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1. Overview 

1.1. Purpose 

The CDR USB Remote HS (High-Speed) (Schick P/N B2250100) is the interface for 
standard CDR Sensors and is compliant with the latest USB version 2.0 specification. 
Adding the CDR USB Remote HS to your office provides the following advantages: 

• Fast image acquisition-to-display time  

• Works with all standard CDR sensors 

• Digital output over high-speed USB 2.0 

• Upgrade utility supports in-office firmware / CPLD updates 

• Built-in sensor emulator for system self-test.   

1.2. Indications for Use 

The CDR USB Remote HS is to be used as part of an intraoral image acquisition system 
and is indicated for individuals requiring intraoral dental examinations.  

1.3. System Description 

The CDR USB Remote HS is connected by USB A-B cable (supplied separately) to a 
compatible PC workstation. The workstation runs Windows Vista or Windows XP and also 
provides the power source for the device. Additional details on the PC workstation may be 
found in Section 1.4. Additional details on the USB cable may be found in Section 2.1. 

Support for the CDR USB Remote HS is provided by compatible software programs such 
as CDR DICOM for Windows 3.5 SR-1 and higher. For other custom applications, a 
programmer’s guide is available.   

The CDR USB Remote HS includes a detachable holder so the device can be mounted 
either by screws to a wall or other stable surface. Details on installing the CDR USB 
Remote HS holder may be found in Section 2.2. 

1.4. PC Workstation Description 

The PC workstation connects to the CDR USB Remote HS via USB cable (supplied 
seperately) and serves as the host for CDR DICOM or other compatible imaging software 
products. The workstation provides the capability to display, manipulate, store, and print 
images acquired from CDR Sensors.  
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Getting the best results from your CDR system begins with having a computer system 
suitable for capturing and displaying intraoral images. For optimum performance, we 
recommend the following: 

1. Compatible operating systems  

• Windows XP Pro and XP Pro x64 Edition, Windows Vista and Vista x64 
Edition 

2. Compatible imaging applications 

• CDR DICOM for Windows 3.5 SR1 and higher, EagleSoft 14.0 and higher, 
and Patterson Imaging 14.0 and higher. 

3. Pentium D processor or Intel Core2Duo processor 

4. 2 GB RAM   

5. 250 GB hard drive Raid Level 1 (practice-specific, depends on number of patients) 

6. Intel USB chipset with at least 2 powered USB 2.0 ports  (USB 1.1 also supported) 
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2. Hardware  

2.1. Connecting Cables to the CDR USB Remote HS  

IMPORTANT! Do not connect the CDR USB Remote HS and cable to your computer until 
after you have successfully run the setup program.  Procedures for installing these files are 
supplied in Section 3, "Software." 

The USB cable used with the device has a Series "A" USB plug on one side and a Series 
"B" USB plug on the other. The "A-type" plug connects to any available USB port on the 
computer. The "B-type" plug connects to the CDR USB Remote HS.  

Table 1. USB Cable Descriptions  

USB Cable Connectors Schick Part Number Cable Length 

B2250150 5 meter (16.5 feet) 

B2250151 2 meter (6.5 feet) 

 

B2250152 
 

0.5 meter (1.6 feet) 
 

 

An illustration of the CDR USB Remote HS is shown below in Figure 1. For a description 
of cable connections to the device, refer to Table 2.  

 

 

Figure 1. CDR USB Remote HS Cable Connections  

Table 2. Description of CDR USB Remote HS Cable Connections  

Number Description 
1 CDR Sensor 
2 CDR Sensor cable edge-card connection 
3 CDR USB Remote HS 
4 USB cable connection ("B" connector end of USB cable connects here) 
5 USB cable connection ("A" connector end of USB cable connects to PC) 

 

1 2 4

5 
3
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2.2. Installing the CDR USB Remote HS Holder 

The CDR USB Remote HS holder is designed for several mounting options: (1) Wall-
mounted with fastening hardware, or (2) Attached to a wall or other acceptable bonding 
surface with Velcro adhesive. When installing your CDR USB Remote HS choose a 
location that offers easy access and visibility during patient exams. 

 
 

Figure 2. CDR USB Remote HS Holder 

2.2.1. Wall-Mounting Option (with Fasteners)  

Install the holder by fastening it to a wall or other flat surface, as follows: 
 
1. Remove the CDR USB Remote HS from its holder before performing this procedure. 

2. Position the holder on a smooth stable flat surface. Using the holes on the back of the 
holder as guides, fasten the holder securely to the wall using 2 (#6 x 3/4) dry wall 
screws (not supplied) or other hardware appropriate to the mounting surface. 

2.2.2. Wall-Mounting Option (with Adhesive)  

Install the CDR USB Remote HS by attaching it with Velcro adhesive to a wall or other 
flat surface, as follows: 
 
1. Remove the CDR USB Remote HS from its holder before performing this procedure. 

2. Cut and trim a piece of Velcro adhesive (not supplied) to the size of the back of the 
Remote. Remove one half of the tape and attach it to the Remote. 

3. Locate an accessible, stable, and flat surface for the Remote. Apply the other half of 
the Velcro adhesive in that location and attach the Remote securely.  
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3. Software  

3.1. What You Will Need to Complete this Section 

To expedite software installation, please have the following items available: 

• CDR USB Remote HS CD 

• CDR USB Remote HS  

• USB 2.0 A-B Cable (supplied separately)  

3.2. Before You Start Installing Software 

IMPORTANT! Please do not connect the CDR USB Remote HS and USB cable to your 
computer until after you have installed the device driver. Procedures for installing these files 
can be found on the following pages.   

The software component to accompany your CDR USB Remote HS installation consists of 
the CDR USB Remote HS device driver. You must install this driver successfully to ensure 
proper operation of your CDR USB Remote HS.  

Installation differs slightly between Windows Vista and Windows XP operating systems, 
so you should follow the procedures that refer to your particular system. (Procedures can 
be found on subsequent pages.) If you're not sure which operating system is installed on 
your computer, right click on the My Computer icon on your desktop and select Properties 
(pressing the Windows Start ( ) and Break keys will also display System Properties).  
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3.3. Setup with Windows Vista 

STEP 1  

A. Insert the “CDR USB Remote HS” CD. 
Setup should start automatically. If it 
doesn't, click Start, Run, and then enter 
d:\ CDR USB Remote HS Driver 
Setup.exe at the command line (if your 
CD drive is a letter other than "d", use 
that letter instead).   

B. Click Next to begin the setup process. 

  

STEP 2  

Click Install.  

 

STEP 3  

Setup will copy the drivers to your 
workstation. 
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STEP 4  

A. Click Finish. 

B. Connect the CDR USB Remote HS to 
your computer. When you do, you will 
receive a momentary message saying 
that new hardware has been installed 
and is ready for use. 

C. Remove the CDR USB Remote HS CD. 
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3.4. Setup with Windows XP 

STEP 1  

A. Insert the “CDR USB Remote HS” CD. 
Setup should start automatically. If it 
doesn't, click Start, Run, and then enter 
d:\ CDR USB Remote HS Driver 
Setup.exe at the command line (if your 
CD drive is a letter other than "d", use 
that letter instead).   

B. Click Next to begin the setup process. 

  

STEP 2  

Click Install.  

 

STEP 3  

Setup will copy the drivers to your 
workstation. 
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STEP 4  

A. Click Finish. 

B. Connect the CDR USB Remote HS to 
your computer. You will receive a 
momentary message saying that new 
hardware has been installed and is ready 
for use.  

C. Remove the CDR USB Remote HS CD. 

 
 

  



    
 

 B1051063 Rev. A  CDR USB Remote HS User Guide 
 

10 

3.5. Using the CDR USB Remote Utility 

3.5.1. Introduction 

The CDR USB Remote Utility is installed during the CDR USB Remote HS Driver setup 
program. This tool can be used to accomplish the following: 

• Perform Sensor Emulator test 

• Perform CDR USB Remote HS firmware upgrades 

• Perform CDR USB Remote HS CPLD upgrades 

A sample screen of the CDR USB Remote Utility is shown below. (Please note that the 
version numbers shown in the picture below are examples only and may differ from those 
reported for your system.)   
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3.5.2. Sensor Emulator Test 

The Sensor Emulator Test checks the connection between the Sensor, CDR USB Remote 
HS, and host computer. A count of 10 test pattern images determines if there are problems 
that could impact the capabilities of your CDR system. A results window, indicating a 
Pass, Fail, Not Detected, or Not Supported message, is displayed at the end of testing.  

• Passed — indicates that the CDR USB Remote HS is operating correctly.  

• Not Detected —is typically the result of a poor or no connection at the CDR 
USB Remote HS or the Sensor. Check these connections and repeat the test.  

• Not Supported — indicates that the currently connected Sensor does not 
support the Sensor Emulator implementation and cannot be tested with this 
function.  

• Failed —may point to a problem with the CDR USB Remote HS device or the 
Sensor. Additional troubleshooting can be performed if another CDR USB 
Remote HS or Sensor is available. In this case, repeating the Sensor Emulator 
Test may help to identify a particular Sensor or CDR USB Remote HS that 
may be functioning incorrectly.  

 
Sensor Emulator Test Perform the following steps to start the Sensor Emulator diagnostic test. 

  
 Step Action 
 1 Close the CDR DICOM or EagleSoft or Patterson Imaging 

program (if running). 
 2 Verify that CDR USB Remote HS and Sensor are connected to 

the host computer. 
 3 Start the CDR USB Remote HS Utility (Start > All Programs > 

CDR DICOM for Windows > CDR USB Remote HS Utility). 
 4 Click Tools > Sensor Emulator Test. 
 

 

 5 Click Close to exit this test. 
 6 Click File > Exit to close the utility. 
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3.5.3. Firmware Upgrade 

Field updates to the CDR USB Remote HS can be accomplished by installing new 
firmware. When new firmware is available, it may be provided with a software release and 
becomes part of the update to your existing system. In the event you are prompted to 
upgrade CDR USB Remote HS firmware, perform the steps provided below.  
 

CDR USB Remote HS  
Firmware Upgrade 

Perform the following steps to upgrade the fimrware in the CDR USB 
Remote HS. 

  
 Step Action 
 1 Close the CDR DICOM or EagleSoft or Patterson Imaging 

program (if running). 
 2 Verify that CDR USB Remote HS is connected to the host 

computer. 
 3 Start the CDR USB Remote HS Utility (Start > All Programs > 

CDR DICOM for Windows > CDR USB Remote HS Utility). 
 4 If the firmware version number is shown in red, click the 

Upgrade Firmware button to upgrade. The firmware version 
number will change to green numbers when the upgrade is 
completed successfully. 

  
 Pictured below is an example of the CDR USB Remote HS Utility, with 

the firmware upgrade button highlighted. 
 

 

 5 Verify that the firmware version number is shown in green. If 
not, please contact your distributor of Schick Technologies 
products for additional information. 
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3.5.4. CPLD Upgrade 

New resources can also be programmed to the Complex Programmable Logic Device 
(CPLD) inside the CDR USB Remote HS. When a new CPLD upgrade is available, it may 
be provided with a software release and becomes part of the update to your existing 
system. In the event you are prompted to upgrade CDR USB Remote HS firmware, 
perform the steps provided below. 
 

CDR USB Remote HS  
CPLD Firmware Upgrade 

Perform the following steps to upgrade the CPLD in the CDR USB 
Remote HS. 

  
 Step Action 
 1 Close the CDR DICOM or EagleSoft or Patterson Imaging 

program (if running). 
 2 Verify that CDR USB Remote HS is connected to the host 

computer. 
 3 Start the CDR USB Remote HS Utility (Start > All Programs > 

CDR DICOM for Windows > CDR USB Remote HS Utility). 
 4 If the CPLD version number is shown in red, click the Upgrade 

CPLD button to upgrade. The CPLD version number will change 
to green numbers when the upgrade is completed successfully. 

  
 Pictured below is an example of the CDR USB Remote HS Utility, with 

the CPLD upgrade button highlighted. 
 

 

 5 Verify that the CPLD version number is shown in green. If not, 
please contact your distributor of Schick Technologies products 
for additional information. 
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4. LED Indicators 

4.1. Understanding CDR USB Remote HS Indications 

The CDR USB Remote HS has two LED indicators (amber and green) for reporting its 
functional status. Customers familiar with other USB Remote Modules from Schick 
Technologies will find that LED indications on the CDR USB Remote HS are identical.  

The location and description of the LEDs is shown in Figure 3 and described in Table 3. 

 

Sensor Cable Side 

 

USB Cable Side 

Figure 3. CDR USB Remote HS LED and Connector Views 

Table 3. CDR USB Remote HS LED Indications 

Action Green LED (P) Power Amber LED (S) Status  Status 

OFF OFF 
Sensor connected or 
USB cable not 
connected CDR DICOM 

not running 
OFF ON Sensor not connected 

or not detected 

CDR DICOM 
is running ON Blinking every ½ - 1½  

seconds Sensor connected 

(CDR DICOM 
not running) OFF ON Sensor not connected 

or not detected 
Changing 
Sensors 

(CDR DICOM 
is running) ON Blinking every ½ - 1½  

seconds Sensor connected 
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5. Operation 

5.1. Operating the Device 

5.1.1. Power On 

1. Turn on the PC workstation used with imaging applications. 

2. Connect the “B-type” end of the USB cable to the CDR USB Remote HS. 

3. Connect the “A-type” end of the USB cable to the PC workstation. 

4. The amber LED on the CDR USB Remote HS blinks momentarily (if the Sensor is 
connected and detected), indicating that power is applied to the CDR USB Remote HS, 
effectively turning the device on.  

5. Continue with Section 5.2 for step-by-step instructions on acquiring X-ray images with 
CDR DICOM software. 

5.1.2. Power Off 

1. Disconnect the USB cable from either the CDR USB Remote HS or the PC 
workstation. 

2. Power is removed from the CDR USB Remote HS, effectively turning the device off. 
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5.2. Using CDR USB Remote HS with CDR DICOM 

NOTE: Refer to the CDR DICOM User Guide, Schick P/N 1051047, for detailed 
information on the use and operation of CDR DICOM software.  

STEP 1  

 Start CDR DICOM from the Windows Start button or by 
clicking the shortcut to CDR DICOM for Windows on 
your desktop. 

STEP 2  

 When the CDR exam window appears, click on New 
Exam under the File menu or just click the New Exam 
button on the toolbar. 

STEP 3  

 A. Enter the appropriate patient information and then 
click on X-ray Series. You may use a pre-defined 
intraoral series or create a new one. 

B. To customize an X-ray series for the current exam, 
click Edit Series, which opens the Edit Viewset 
dialog box. (Re-usable, customized series can be 
created at the Series > New Intraoral Series menu.)  

C. The numbers in the text boxes correspond to how 
many target frames (view boxes) are included in this 
series. You can edit the numbers, creating a series 
customized with the views you wish to include. 

D. Enter a name for this X-ray series. Click OK. 

STEP 4  

 A. Slide an appropriately-sized sheath over the Sensor. 
Select a CDR positioning holder specific to the 
intraoral area intended for exposure and apply it to the 
sheath. Attach positioning arm and aiming ring, as 
needed.  

B. Verify the X-ray exposure settings. Proper technique 
factors depend on several variables, among them, the 
type of  X-ray tube, the anatomy of the patient, and the 
location of the Sensor in the oral cavity. 
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STEP 5  

 A. If your acquisition mode is set to AutoTake, the first 
empty view box in the exam is pre-selected and 
flashes green (default setting). Skip ahead to step 7. 

B. If your acquisition mode is set to manual, select an 
empty target frame that corresponds to the Sensor’s 
location in the patient’s mouth. When the view box is 
highlighted, click on it again. If you are using a serial 
footpedal, press the amber pedal. 

STEP 6  

 
The system is ready to acquire an X-ray image. A “Please 
Wait” message may appear momentarily.  

STEP 7  

 A. In AutoTake mode, activate the X-ray source. The 
message, “Reading Image from Sensor” appears 
momentarily.  

B. In manual mode, activate the X-ray source when the 
message, “Waiting to take X-ray” appears. 

C. The acquired image appears automatically in the zoom 
or exam window, depending on system settings.  

STEP 8  

 A. In AutoTake mode, the next empty view box in the 
series sequence is selected. To acquire the next X-ray 
image, repeat this procedure starting at Step 7.  

B. In manual mode, close the exam window. To acquire 
the next X-ray image, repeat this procedure starting at 
Step 5.  

 



    
 

 B1051063 Rev. A  CDR USB Remote HS User Guide 
 

18 

5.3. Acquiring X-ray Images with the Footpedal  

Serial footpedals (Schick P/N B2501100; PDCO P/N 07-0410100) can be used to navigate 
view boxes inside a patient exam and to control the capture of X-ray images. Refer to the 
following table for information. 

Table 4. Footpedal Actions 

Desired Action Use Pedal 
Select a view box Green 
Take an X-ray (manual mode) Amber 

 

5.4. Acquiring X-ray Images with Keyboard Shortcuts  

Intraoral image acquisition can be also accomplished though the use of shortcut keys. 
Refer to the following table for information. 

Table 5. Keyboard Shortcuts 

Desired Action Use Keys 
Select a view box [Spacebar] or [Page up] or [Page down] 
Take an X-ray (manual mode) [Insert] or [Enter] 
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6. Protective Measures  

6.1. Cleaning  

IMPORTANT! Be sure to disconnect the CDR USB Remote HS from the Sensor and the 
USB cable before performing any cleaning procedures.  

To clean the CDR USB Remote HS, use either of the following solutions and observe the 
precautions noted below. Do not soak or immerse the CDR USB Remote HS and be sure to 
dry it completely afterwards.  

• Mild soap and water 

• Isopropyl alcohol (70%) 

Clean the surface of the CDR USB Remote HS by moistening a soft cotton swab dipped in 
either of the cleaning solutions listed. Gently wipe the surface from end-to-end in straight 
lines without applying pressure. Do not allow any amount of liquid to enter the device 
through the USB cable or Sensor cable connectors. 

After cleaning the surface of the CDR USB Remote HS, use a clean lint-free cloth to dry 
the device, as needed, until the surface is clean. 

To avoid cross contamination, follow the cleaning instructions provided by your computer 
manufacturer and implement them as part of your normal routine for ensuring proper 
sterilization and disinfectant of tools and other devices in your dental practice.  
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7. Maintenance 

7.1. Visual Inspection 

Like all electrical equipment, the CDR USB Remote HS requires not only correct use, but 
also visual inspection prior to operation, and routine checks at regular intervals. These 
precautions will help ensure that the CDR USB Remote HS operates accurately, safely, 
and efficiently. 

There are no user-serviceable components in the CDR USB Remote HS. However, before 
operating the system, users shall check it for any signs of physical damage or defect. If 
detected, contact your local distributor of Schick Technologies products for further 
instructions. 

7.2. Periodic Maintenance 

Periodic maintenance is performed as needed, but at least once a month. It consists of 
various checks performed by the operator or by a qualified service technician.  

• Check that the labels are intact, readable, and adhere well to the surfaces on 
which they are positioned  

• Check that all of the cables that connect to the CDR USB Remote HS are 
undamaged  

• Check that there is no external damage to the CDR USB Remote HS which 
could compromise its ability to operate safely  
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Appendix A.  Reference  

A-1. Removal and Replacement Procedures 

There are no user-serviceable parts in the CDR USB Remote HS. Should you experience 
problems with the CDR USB Remote HS, please contact your local distributor of Schick 
Technologies products. In the United States, Schick Technologies products are available 
exclusively through Patterson Dental Supply, Inc. Call your local Patterson representative, 
local Patterson branch, or 1-800-873-7683 for more information. 

A-2. Summary of Specifications  

CDR USB Remote HS is ETL-certified and complies with safety standards listed below.  

Table 6. Specifications 

Item Value 

CAN/CSA C22.2 
No.601.1-M90 

Medical Electrical Equipment Part 1: General 
Requirements for Safety 

EC93/42/EEC Medical Device Directive 

IEC60601-1 Medical Electrical Equipment Part 1: General 
Requirements for Safety 

IEC60601-1-2 
Medical Electrical Equipment Part 1: General 
Requirements for Safety 2.Collateral Standard: 
Electromagnetic Compatibility – Requirements and Tests  

EMC/Safety 

UL60601-1 Medical Electrical Equipment: General Requirements for 
Safety 

Classification Class II, Type BF equipment   
Not Category AP Equipment  
Not Category APG Equipment 

Mode of Operation Equipment is intended for continuous use 

Additional Notes Equipment is not suitable for use in the presence of a Flammable Anesthetic 
Mixture with Air or with Oxygen or Nitrous Oxide. 

Supply Voltage +5V DC (derived for PC USB port) 

Supply Current 250 mA  
Power Consumption 1.25W 
Dimensions 3.25 x 2.3 x 0.9 in. (1.28 x 0.91 x 0.35 cm) 
Weight 1.8 oz. (50g) 

Transport and Storage 
Conditions 

Ambient temperature range: -40° F (-40° C) to 158° F (+70° C) 
Relative humidity range: 10 to 100%, including condensation 
Atmospheric pressure range: 500 hPa to 1060 hPa 

Operating Conditions 
Ambient temperature range: 50° F (+10° C) to 104° F (+40° C) 
Relative humidity range: less than 75% 
Atmospheric pressure range: 700 hPa to 1060 hPa 
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Item Value 

Restricted service 
statement 

Unless otherwise specified, this unit should be serviced only by the 
manufacturer. It contains no user-serviceable parts. 

External power supply None (power supplied via USB) 

Maximum cable length 5 m (5.5 yds) 

A-3. Leakage Current Statement 

CDR USB Remote HS complies with the leakage current requirements of IEC 60601-1-1 
safety standard. Variations, however, may exist in the construction of computers to which 
the CDR USB Remote HS is connected. Customers are advised to have a qualified 
electrician perform a leakage test on their equipment before using the CDR USB Remote 
HS.  
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A-4. EMC Tables 

The following tables provide CDR USB Remote HS compliance information to 
electromagnetic compatibility (EMC) and electromagnetic immunity (EMI) standards. To 
ensure conformance, the customer or user must use the CDR USB Remote HS in 
environments that are consistent with these standards.  

The USB cable required with the CDR USB Remote HS device must also comply with the 
same standards. The operation of the CDR USB Remote HS has been independently tested 
using USB cables identified in Table 1. Compliance to EMC and EMI standards cannot be 
guaranteed by the use of alternate cables. 

Table 7. Guidance and Manufacturer's Declaration - Electromagnetic Emissions 

PLEASE NOTE: The CDR USB Remote HS is intended for use in the electromagnetic environment specified below.  The 
customer or user of the CDR USB Remote HS must ensure that it is used in such an environment. 
 
Emissions Test Compliance Guidance 
RF emissions 
CISPR 11 

Group 1 The CDR USB Remote HS uses RF energy only for its 
internal function. Therefore, its RF emissions are very 
low and are not likely to cause any interference in nearby 
electronic equipment. 

RF emissions 
CISPR 11 

Class B 

Harmonic emissions 
IEC 61000-3-2 

Class D 

Voltage 
fluctuations/ flicker 
emissions 
IEC 61000-3-3 

Complies 

The CDR USB Remote HS is suitable for use in all 
establishments including domestic establishments and 
those directly connected to the public low-voltage supply 
network that supplies buildings used for domestic 
purposes. 

 
Table 8. Guidance and Manufacturer's Declaration - Electromagnetic Immunity 

PLEASE NOTE: The CDR USB Remote HS is intended for use in the electromagnetic environment specified below. The 
customer or user of the CDR USB Remote HS must ensure that it is used in such an environment. 
 

Immunity Test IEC 60601 Test 
Level 

Compliance 
Level Guidance 

Electrostatic discharge 
(ESD) 
IEC 61000-4-2 

±6 kV contact 
 
±8 kV air 

±6 kV contact 
 
±8 kV air 

Floors should be wood, concrete or 
ceramic tile.  If floors are covered 
with synthetic material, the relative 
humidity should be at least 30%.   

Electrical fast 
transient/burst 
IEC 610004-4 

±2 kV for power 
supply lines 
±1 kV for 
input/output lines 

±2 kV for power 
supply lines 
±1 kV for 
input/output lines 

Mains power quality should be that 
of a typical commercial or hospital 
environment. 

Surge 
IEC 61000-4-5 

± 1 kV differential 
mode 
± 2kV common 
mode 

± 1 kV differential 
mode 
± 2kV common 
mode 

Mains power quality should be that 
of a typical commercial or hospital 
environment. 
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Immunity Test IEC 60601 Test 
Level 

Compliance 
Level Guidance 

Voltage dips, short 
interruptions and 
voltage variations on 
power supply input 
lines 
IEC 61000-4-11 

< 5% UT 

(>95% dip in UT) 

for 0.5 cycle 
 
40% UT 

(60% dip in UT) 

for 5 cycles 
 
70% UT 

(30% dip in UT) 

for 25 cycles 
 
< 5% UT 

(>95% dip in UT) 

for 5 sec 

< 5% UT 

(>95% dip in UT) 

for 0.5 cycle 
 
40% UT 

(60% dip in UT) 

for 5 cycles 
 
70% UT 

(30% dip in UT) 

for 25 cycles 
 
< 5% UT 

(>95% dip in UT) 

for 5 sec 

Mains power quality should be that 
of a typical commercial or hospital 
environment.  If the user of the 
CDR USB Remote HS requires 
continued operation during mains 
interruptions, it is recommended 
that the PC workstation to which the 
CDR USB Remote HS  is connected 
be powered from an uninterruptible 
power supply or battery. 
NOTE:  UT is the AC mains voltage 
prior to application of the test level. 

Power frequency 
(50/60 Hz) magnetic 
field 
IEC 61000-4-8 

3A/m 3A/m  

Conducted RF  
IEC 61000-4-6 
 
 
 
 
 
 
 

3 Vrms 
150 kHz to 80 MHz 
 
 
 
 
 
 
 

3 Vrms 
 
 
 
 
 
 
 
 

Portable and mobile RF 
communication equipment should 
be used no closer to any part of the 
CDR USB Remote HS, including its 
cables, than the recommended 
separation distance calculated from 
the equation applicable to the 
frequency of the transmitter. 
 
Recommended separation distance: 
d=  1.2 √ P 
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Immunity Test IEC 60601 Test 
Level 

Compliance 
Level Guidance 

Radiated RF  
IEC 61000-4-3 

3 V/m 
80 MHz to 2.5 GHz 

3 V/m d=  1.2 √ P  for 80 MHz to 800 
MHz 
d=  2.3 √ P  for 800 MHz to 2.5 
GHz 
 
Where P is the maximum output 
rating of the transmitter in watts 
(W) according to the transmitter 
manufacturer and d is the 
recommended separation in meters 
(m). 
 
Field strengths from fixed RF 
transmitters, as determined by an 
electromagnetic site survey,a should 
be less than the compliance level in 
each frequency range. b 

 
Interference may occur in the 
vicinity of equipment marked with 
the following symbol. 
 
 
 

NOTE 1: At 80 MHz and 800 MHz, the higher frequency range applies. 
NOTE 2: These guidelines may not apply in all situations.  Electromagnetic propagation is affected by 
absorption and reflection from structures, objects and people 
a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile 
radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. 
To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be 
considered.  If the measured field strength in the location in which the CDR USB Remote HS is used exceeds the 
applicable RF compliance above, the CDR USB Remote HS should be observed to verify normal operation.  If 
abnormal performance is observed, additional measures may be necessary, such as reorienting or relocating the CDR 
USB Remote HS. 
 
b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m 

 
Table 9. Recommended Separation Distance Between Portable and Mobile RF 

Communications Equipment and the CDR USB Remote HS  

PLEASE NOTE: The CDR USB Remote HS is intended for use in an electromagnetic environment in which radiated RF 
disturbances are controlled. The customer or user of the CDR USB Remote HS can help prevent electromagnetic 
interference by maintaining a minimum distance between portable and mobile RF communications equipment 
(transmitters) and the CDR USB Remote HS  as recommended below, according to the maximum output power of the 
communications equipment. 
 
Rated maximum output 
power of the transmitter 
(W) 

Separation distance according to the frequency of the 
transmitter (m) 

 150 kHz to 800 MHz 
d=1.2 x √P 

800 MHz to 2.5 GHz 
d= 2.3 x √P 
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0.01 0.12  0.23 
0.1 0.38  0.73 
1 1.2  2.30 
10 3.8  7.3 
100 12.0  23.00 
For transmitters rated at a maximum output power not listed above, the recommended separation distance d 
in meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is 
the maximum output power rating of the transmitter in watts (W) according to the transmitter 
manufacturer. 
NOTE 1: At 800 MHz, the separation distance for the higher frequency range applies. 
NOTE 2: These guidelines may not apply in all situations.  Electromagnetic propagation is affected by 
absorption and reflection from structures, objects, and people. 
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Appendix B. Troubleshooting Tips 

B-1. Introduction 

In the event you experience a problem with the CDR USB Remote HS, refer to the table of 
troubleshooting tips found on this page. If the problem persists, please contact your local 
distributor of Schick Technologies products.  

In the United States, Schick Technologies products are available exclusively through 
Patterson Dental Supply, Inc. Call your local Patterson representative, local Patterson 
branch, or 1-800-873-7683 for more information.  

B-2. Troubleshooting Table 

Please refer to Section 3.5 for details on using the CDR USB Remote Utility, including 
information on how to perform the Sensor Emulator Test, or refer to the following table for 
additional information. 

Item Description Corrective Action 

1 CDR USB Remote HS LEDs do not 
illuminate when the imaging application is 
running. 

Check that the USB cable is plugged correctly into 
the Remote. 
Check that the Remote has been installed and is 
listed in the Windows Device Manager 
Reset the hardware by unplugging the USB cable 
from the Remote and reconnecting it. 

2 Either the green LED (by itself) or both 
LEDs (amber and green) are on 
continuously before the imaging application 
is running. 

Hardware error. Unplug the USB cable from the 
Remote and reconnect it.  Contact Customer 
Support if the problem persists. 

3 Amber LED is continuously on (whether the 
imaging application is running or not). 

Check that the Sensor is connected properly, or use 
another sensor. 

4 Green LED does not illuminate when the 
imaging application is started. 

USB communication error. Open the Windows 
Device Manager to ensure that the device was 
installed correctly. 

5 Amber LED blinks once every 3 seconds. The firmware in the Remote has been corrupted, or 
the Remote is damaged. 
Start the CDR USB Remote HS Utility and 
reprogram the Remote, or use another Remote. 
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